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Resetting the Calculator

Step 1: Step 2:
Press to [k onl [2 110 open my Press menu. Select C: Delete All.
documents.
4[] A
B 3: Save As...
& My Documents : [# 4: Collapse
[ _other_Files 353K 5: Close (Ctri+W
& _sci Nspired 1.0M 6: Send
-.7\_ clence_Nspire . g 7: Expand All
|55 Fun Files 0K < 8: Collapse All
(5 Geometry OK 9: Settings & Status P
[ T1-Nspire Document Examples 0K % A: Send OS
[ Data 53K B: Refresh Libraries
n :
[ Homework S5KM C:Delete All

Step 3: Step 4:

The Data Loss box opens. Click OK to Click OK to complete.
confirm clearing the data.

"
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E
=

-

& Mv Documents 1.4M

Al Calculate
Data Loss. = =

Handheld Reset

This operation will delete all files and folders on
this device. Do you wish to proceed?

|Cancel|

— S PTE DTS TTE T EROTET o
[ Data 53K
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g Leave Press-to-Test §

To exit Press-to-Test mode, you need two calculators.

Step 1:

Step 2:

Connect the calculators with cable provided
when you bought the calculator, then turn
both on.

Press OK on the calculator that you are going to
take out of press to test mode

Step 3:

Step 4:

Then select My Documents

Press Doc and go down to press to test, then

press enter




Reset Graphing Window H

Step 1: Step 2:

Select the graph option on the home screen, Go to the fourth option and select

then when you are on the graph screen press Window/Zoom after selecting this more

menu options should come up select their first one it
says Window Settings

Step 3: Step 4:

Then Finally to change the graphing window

on window setting change the Xmin or Xmax

then you have reset the graphing window

Clearing Graphs/Calculations

SBD
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Step 1: Step 2:
Click Menu, Click #1 (Actions) Click #5 (Clear History)
: Actions » 1: Define
1,5 2: Number » p|2: Recall Definition i
\= 3: Algebra 4 M|3: Delete Variable
& 4: Calculus » 4: Calculus Pl4: Clear a—z...
@ 5: Probability 4 W 5: Probability 4 5: Clear History
X 6: Statistics > < 6: Statistics » é:]hsert Comment
[83] 7: Matrix & Vector b e 7: Matrix & Vector M by g
$ ¢ 8: Finance » $¢ 8: Finance Al >
4-54+2:6 4-5.4+2:6 S
| [
Clearing Graphs
Step 1: Step 2:
Click Menu, Click #1 (Actions) Click #6 (Delete All)

k 1: Actiong k 1: Pointer
| i 8 2: View |'& 2: Select

ks 3: Graph Entry/Edit b 7 3: Graph|® 3: Hide/Show
8 2: Window /0GR 24 % 4: Windov = 4: Attributes

| 5: Trace > £7,5: Trace |#E 5: Set Conditions

{ 6: Analyze Graph P = R T4 %) 6: Delete all
=7 @L.._J i ==if Table_;mexg
« 8: Geometry 4 ; 8: Geomd#® 8: Coordinates and Equations
111 9: Settings... 9 Setting a"b 9: Calculate
"+2 A:Redefine
# B:Insert Slider




Find Factors of a Number §§ﬁ

Step 1:

Step 2:

Step 3:

Go to calculate

1 New Document
My Documents

Press Menu, select number

Matrix & Vector )
F »

Press Factor

Step 4:

Step 5:

Step 6:

Enter the number, press Enter
(Example: 20)

Rewrite the number (2x2x5)

Take 2 of the same Number,
put it on the outside of the
radical. (2 radical 5). Repeat
until simplest radical form




0.25

Increase Number of Decimal Places

0.25

Step 1:

Step 2:

Step 3:

Al Calculate

Graph

Click: 5 (Settings)

Click: 2 (Document Settings)

7:T—novtor l .

Click on Display Digits

Document Settings

Exponential Format: | Normal

Display Digits: | Float6 =
Angle: | Radian 3
Real or Complex:

Calculation Mode: | Auto

[
Vector Format: | Rectanaular =

FI lRestoreI |Make Defaultl ICancelI

Step 4:

Step 5:

Step 6:

Document Settings

Display Digits:
Angle:
Exponential Format:
Real or Complex:
Calculation Mode:

Vector Format:

I?I IRestore' |

Scroll down to float 12

Float 12

Float 4
FloatS
Float 6
Float 7
Float 8
Float9
Float 10
Float 11
Float 12

Click: make default

Document Settings

Display Digits:
Exponential Format:
Real or Complex:

Calculation Mode: |
Vector Format: | Rectanaular =l I

FI lRestorel IMake Def.aultl lCancell

=l

Click: OK

Document Settings

Float 12
Apply and Save as Default

Apply your settings and save them as default

for new documents and Scratchpad?

[cance]




Convert from Fraction to Decimal

Step 1: Step 2:
Go to New Document. After that, press Add | Put in the fraction or numbers you are
Calculator dividing.

& 1:Add Calculator = B

9412:Add Graphs

1N3:Add Geometry 5/4

:-|4:Add Lists & Spreadsheet

1)5:Add Data & Statistics

6:Add Notes

:47:Add Vernier DataQuest™

J8:Add Widget

49:Add Program Editor

=

Step 3: Step 4:
Press CTRL then ENTER After you’ve done that, you should have the

fraction and the decimal.

B
4

5
4
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Check Factors of a Polynomial

Step 1:

Step 2:

Step 3:

Make a new document

Hit the Menu and press Algebra

Press factor

Step 4:

Step 5:

Insert polynomial in parenthesis

Hit enter and see factors on the right

(e+1) (247,

11




Reduce Fractions

Step 1:

Step 2:

Press calculate on the home screen.

1
2) My
3 F
4
5

Settings

COLeane®

5/10.

& | #/ | Scratchpad <

Enter the fraction you want to reduce. In this
example, it is

RAD i %

5/10|

Step 3:

Step 4

Press Enter

g ﬂ;} Scratchpad <

The fraction on the right is your reduced
fraction.

RAD ] X%

[

12




Find Coordinates of a Vertex

Step 1:

Step 2:

Step 3:

Graph a function that has

either a maximum or a
minimum.

bR 1Y

Click “menu”, “analyze
graph”, and click either
“maximum” or “minimum”,
depending on what your

graph has.
R 1: Actions )
g1 2: View )

#t: 3: Graph Entry/Edit »
T 4: Window / Zoom
£\, 5: Trace

\'!' 6. Analyze Graph
“47: Table

A 8 Geometry

11l 9: Settings...

&, 1: Zero
% 2: Minimum

X 4: IMersection

& S Inflection

65 6: dy/dx

ke 7: Integral

¥ 8: Bounded Area

© 9: Analyze Conics »

Place the “lower bound” line
to the left of the vertex and
click “enter”, and place the
“upper bound” line to the
right of the vertex and click
“enter”

B f1(x)=-3 X246 x42
e

:
b
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§ Calculate Five Number Summary/Mean §

Step 1: Step 2: Step 3:
To find the five number After you press menu select In the top box of the first
summary and mean #4 Add Lists & Spreadsheets | column name the variable
First select new document on 1.1 Do B i
the home screen @[ speed P 2 2 (1

= 1:Add Calculator 1-

#12:Add Graphs

ISB:Add Geomet 2

15:Add Data & Statistics 3

_ 6:Add Notegs 7

-4 7:Add Vernier DataQuest™

5 8:Add Widget 5

:49:Add Program Editor i 1|

4| speed | 4 | »
Step 4: Step 5: Step 6:
Input your data in the first When you finish inputting the | When you select this box
column data move to a box next to the | press the menu button
column

|329| | 4 | b
Step 7: Step 8: Step 9:
After you press menu select Select “Stat Calculations” Select #1 One-Variable
“Statistics” Statistics

14
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2 1 Action
1: One-Variable S

F= 1: Actions = 1: Actions *Dog =

(£ 2: Insert 1 2: Insert c b = S

135 3 1353: Data » 2: Two—Variable Statistics...

T m T 4: Statistics M= 3t Calculatio 3: Linear Regression (mx+b)... »

E5:Table  b| E5:Table  »| 2 Distributions p| [ | 4 Linear Regression (@+bx).. »

27 2 27 8 3: Confidence Intervals » 5 Median—lMedian Lir?e... 4

A: Stat Tests » 6: Quadratic Regression... »

H 42 28 42 7: Cubic Regression...

29 29 8: Quartic Regression...

= = | 9: Power Regression... 1
~ 5 A:Exponential Regression... ~

[52s] [4T»] 329| |€|D b |1|b

Step 10: Step 11: Step 12:

On the next screen press In the X1 List press the pad Scroll down and press OK

“OK” right and select the name of

the first column P —
X1 List: | 'speed 2] gory
‘age |2g| Include Categories: l:l
|29}
30
B2

One-Variable Statistics

Frequency List:

'speed
Categorylist: | ]
Include Categories: l:l
30 Ll 1st Result Column: | c[]

329| | 4 | L I&' Canceli =

Step 13: Step 14:
Rows 8-12 display the 5 Row 2 or x will display the
number summary mean

= =0neVar( = =Cnevar(

2 {IMinx 16. T Title One-Va..

9 lawx 18. 2 |z 22.

19| IMedianx.. 20. 3 ||zx 616.

11 |Qax 23. 4 ||zx? 14724,

12/ Maxx 2. = | 2 |[sx:= sn-..|6.58842.. =
Di10| =20. | 4 | b Dz|=22. | 4 ‘ .2

15



Graph Square Root Function

Step 1:

Step 2:

Step 3:

Turn on the calculator with
the “on button”.

Press 1: to create a new

document.

Press 2-to add graphs

& 1:Add Calculator
U 2:Add Graphs

1N 3dd Geometry

::]4:Add Lists & Spreadsheet
[15:Add Data & Statistics
6:Add Notes
7:Add Vernier DataQuest™
(&8:Add Widget
=9:Add Program Editor

Step 4:

Step 5:

In order to graph the square
root of “x”, you would press
ctrl, “x squared”, then “x”,
and then press enter to see
the graph.

(optional): If you would like
to see the table of values for
this graph you must simply
press “ctrl’’ and “t” and to
get rid of the table just press
“ctrl’’ and “t” again.

16




Graph Absolute Value Functions

Step 1:

Step 2:

Step 3:

Calculate
B! Graph

1
2
3
E
<

Settings

COCenen®

Press the button that looks
like boxes to the left of the
book

Select absolute value sign
when table comes up

BERGEEEEBEEE
.mmwmmymaﬁﬂ
¢ |[fa o 1 T

\ve

Step 4:

Step 5:

Insert function into table after
absolute value signs are
selected

B 770(x)=|x+3]-1]

Hit enter and see your graph!

flo(x)=lx+3|-i 1

17




(o)

050 Graph a Piecewise Function (o
l &l
Step 1: Step 2: Step 3:
Click: Add Graphs Click: Book Key

Click: New Document

New Document

ent

Step 4:

Step 5:

Go to #4

Click: Piecewise Function

4:fd
%o |o)%0| | ] 6 linl
oo | (B8] |0 | E] 1Bl | £ | i 0| 2o | 30 | o

e 5

18




Making a Box Plot

Step 1:

Step 2:

Step 3:

Open a new document from
the homescreen

f___ 4

Document
viy Documents

Add a new spreadsheet by clicking menu
and choosing option four, “Add Lists &

Spreadsheet.”

Name your spreadsheet and enter
your data.

*Unsaved <

*Unsaved <

13 8 [
14 o |
PRI 5[ |
135 Adn Data B Stabetics 16 |
l'E-E_.-‘--d;.' Prlerles 17 L
7 A Wernler Catad g s |
- Fress men. 415] 16| H I >
Step 4: Step S: Step 6:
Hit the control button (ctrl), | A new screen should appear with your data | At the bottom of the screen where
then the button that says plotted. your data is plotted, there is a
Adoc. ; Hould EEE el el rectangle that says “Click to add
new document shou CRphlaniilate variable” where the name of the
appear with the same seven 2 & i Iv is. Wh lick
options from before : "% e o X-axis usually 1s. When you clic
Choose option five, “Add E o o on this rectangle, an option to
Data and Statistics.” S o ¢ 3 choose a list from your spreadsheet
¥ oo: ¢ should appear. Click on the data list
#H\dd Calculator il that you
w12:Add Graphs lick to add variable

N3:Add Geometry

:-|4:Add Lists & Spreadsheet
M 5:Add Data & Statistics |
6:Add Notes
:47:Add Vernier DataQuest™

Press menu

want to
make into
a box plot.

19




Step 7:

Step 8:

Step 9:

When you click on your list,
your data should become
plotted in a dot plot.

11012

Click to add variable

To make your dot plot into a box plot,
press menu, then choose option 1, “Plot
Type,” and lastly from there, choose
option 2, “Box Plot.”

£ 11: Plot Type |:i: 1: Dot Plot
E'R V=GR 2: Box Plot |
K 3: Actions |l 3: Histogram
[ 4: Analyze 1 4: Normal Probability Plot
|9 5: Window/Zo| Scatter Plot
E nd Y Line Plot
#1.7: Dot Chart
& 8 Bar Chart
& o: Pie Chart
T T T T T T
6 8 10 12 14 16
data

Clickto a

~-100
¢
¢
q

Your finished Box Plot should
look something similar to this...

Click to add variable

0 2 4 6 8 10 12 14 16
data

With your finished Box Plot, you
can easily find and display the
five-number summary of your
data (Lower Extreme, Q1,
Median, Qs and Upper
Extreme) plus any outliers you
may have within your data set...

1.141.2

Median: 8

ck to add wvariable

Cli

10 12 14 16
data

20




Making A Scatter Plot

Step 1:

Step 2:

Step 3:

Step 4:

Click 1: New Document

Click 4: Lists and
Spreadsheets

Click the up arrow twice

to get to the top gray box.

Add a title using letters.

Click the down arrow to get
to the first white box. Add
your numbers in.

(Do the same with both sets
of numbers)

B4, BN C o 5 g
6:Add Notes E @A x B e b =
§7:Add Vernier DataQuest™ i = ﬂ
&)8:Add Widget ; T ‘ ‘
19:Add Program Editor » i - \ i
| 3 [
b L 4 J
. F, i | B L
a1 [«T»]
Step 5: Step 6:
When done, click the Click control. Click menu. Click A: Quick Graph

down arrow so you aren’t

in a number box.

[«T»

® A x 2:Coby

= 3:Paste

1 1 8 4:Insert Cell
S:Delete Cell

2 3 g |6:Fill

?7 7:Variables

— Z 2 8:Resize

g 5 6

>

55 <

21




Making A Histogram

Step 1:

Step 2:

Step 3:

Select New Documents
Click: 4. Add Lists &

Insert title for Column A.
Insert data in each section for

Click: Ctrl on the left side
Click: Doc on the right side

Spreadsheet Column A Click: 5. Add Data &
Statistics
1 # 1:Add Calculator
Data W12:Add Graphs
: 2 | Data 3:Add Geometry
:§7:Add Vernier DataQuest™ 3 b jidxAdd Lists & Spreadsheet
Press menu 1) ata ~16:Add Notes
4| Data :§7:Add Vernier DataQuest™
e T Press menu
3| Data | 1 |~
41 [4]»
Step 4: Step 5:

Click on the bottom to add a
variable

]

RAD AUTO REAL 7]

) add variable

No lists in this problem

lick to

Click menu on the right side
Select 1. Plot Type
Select 3. Histogram

i 2: Plot Proper| @ pRIP a6
k 3: Actions |
4 4: Analyze | 4: Normal Probability Plot
2 5: Window/Zo|

J
00 ©
© ooo0¢
145 150 155 160 165 170 175 180 185 190
height

N

22




Finding Linear Regression

Step 1: Step 2: Step 3:
Make a new document. Select Add Lists or Enter your x and y values into
Spreadsheets. the corresponding columns.

TI-725pire
A

W Scratchpad
9 Colculate
Grar

5 i) (@) (2

r-72spire

TI-72spire
¥ Texas INsTRUMENTS

o
o -
o
@ om
Step 4: Step 5: Step 6:
Click Menu, go to Statistics, | Change the name of the x list | Press Control I and Add

then Stat Calculations.
Select Linear Regression
(mx+b).

TI-725pire
&P TExas INSTRUMENTS

to the name of your x variable
and the name of your y list to
the name of your y variable.

Data and Statistics.

23




Step 7: Step 8: Step 9:

When prompted, add in the Click Menu, Analyze, Whoopee, you’re done!
names of your x and y lists Regression, Show Linear

into their corresponding (mx+b).

boxes.

TI-72spire
A Texas INsTruMENTS

24



Finding the Correlation Coefficient

Step 1:

Step 2:

Step 3:

Open up a new Data &
Statistics document with the
icon that looks like a

List all of your bivariate data
inside the two columns.

1

Identify which variable is the
X-variable and which
variable is the Y.

N, »
spreadsheet. I "
0 5.9] | . y
EESLTO TS - I|I T
5 6 2 7
= 6 62 g 5.8
B 5 6
B 6 62
Step 4: Step S: Step 6:
Name both variables by Once you’ve named both Look for the option named

selecting the top box in the
column and entering the
name.

variables, hit the menu button
on the keypad.

Statistics and click on it.

2 1: Actions D

i) 2: Insert »

2 3: Data »

~
1] 2: Insert »
A 1353: Data » S: Table  MJ2: Distributions
N y % 4: Statistics » 2 3: Confidence Intervals
S:Table B S SI I . 3 4: Stat Tests
0o sq | B 2 7 5 6
2 7 L 58 6 62 ‘
B 58 5 . c <
c | [«]»
| 5 6 B 6 6.2
B 6 6.2 = = U
Fert nn
Step 7: Step 8: Step 9:

Then, click on the option
named Stat Calculation.

Actione *Unsaved — L

: One-Variable Statistics. ..

Two~-Variable Statistics

Linear Regression (mx+b) »

Linear Regression (a+bx) »
»
»

il <
A

Median-Median Line

uadratic Regression...

Cubic Regression

Quartic Regression... ‘

Power Regression. .. ‘ I

A: Exponential Regression... v
»

v [Ty

tervals

DoNoOowvseuUuVE q

Select the option Linear
Regression (mx+b).
| Y
ns M
b
: Median-Median Line... tervals P
: Quadratic Regression... »
7: Cubic Regression...
8: Quartic Regression...
9: Power Regression...
A:Exponential Regression...

| v
= 4/r

1

2

K] ]

4: Linear Regression (a+bx)...
5

6

With the new menu, click on
the arrow for the x list and
select your x variable.

k v List [

Save RegEqnto | 11
Frequency List | 1 |
Category List

Include Categories. [

25




Step 10:

Step 11:

Step 12:

Then do the same thing for
the y list, clicking the arrow

and selecting your y variable.

X List (
I ¥ List ,{
Save RegEqn to
I Frequency List [V )
= Category Lls(
B Include Cateqories. |
o lc_i 7

Hit OK and then two more
columns should have
appeared.

1

Scroll down until you find a
box on the third column
named » which is your
correlation coefficient.

.y 3 11
=LinRegM n, o
] 55 Title Lmear Pe] I,_,_W;ET;Q_M
I- 7 RegEqn  m*x+b ' 58 m 0018182
|; N 58 m 0.018182 b 6
l 6 b 6 62 s 0.007383
l = 5 0.007383 r 0.085927
= r—— | Resid {0.509..
o T s Raprton sy 41> £ | -*Lneer Pognmion gurty” [ 4>

26




Finding Exponential Regression

Step 1:

Step 2:

Step 3:

Press ctrl and then doc
Press option 4. Add lists and
spreadsheet

+=1:Add Calculator
141 2:Add Graphs

Enter in x data values for one
column and label.

On the column next to it,
enter in your y values for

Press ctrl and then doc to

make a second document

Press option 5. Data and
Statistics

your data and label. On the bottom, where it says
: preadsheet click to add variable, press
J.Ig gﬂg ngs& Statistics 1 poaores B | that and click on your label
:47:Add Vernier DataQuest™ S T for your x values. Do the
sl 1091 same for the y values on the
42| 1057 side
;3 :zgz [ RAD AUTO REAL B
Blhmp || é
E Mo lists in this problem
§ K
Click to add wariable
Step 4: Step 5: Step 6:

After your exponential graph is
shown, press menu

Press 4. Analyze

Press 6. Regression

Press 8. Show exponential

= 1: Plot Type Yo AuTo R

52 Plot Pro ertles lD el u
Points

1 Show Linear (mx+b) ible Line

2: Show Linear (a+bx) Selected

3: Show Median-Median ept at Zer

4: Show Quadratic n N

5: Show Cubic jual Sauare

6: Show Quartic mal PDF

7: Show Power

Ao don

9: Show Logarithmic der Functior

A:Show Sinusoidal I

B: Show Logistic (d=0) 304U SU

C:Show Logistic (d#0) e I

On the graph drawn, the
exponential regression should
be labeled

RAD AUTO REAL L

O y = 171.4620007(988247)Ax
o

“time”

27




Finding Quadratic Regression

&)

Step 1:

Step 2:

Step 3:

Step 4:

Create new list and
spreadsheet

ool
=)
A o}

Add Lists & Spreaguhest (o Hew Documaent

Punch in your numbers
and label the x and y
axis

Click control then doc to

add calculator
-

i rEp
3 Acd Geormelry
A Add Lists & Spreadsheet
5:Add Data & Statistics

6:Add Maotes
(37 Add Vernier DataQuesT™

Click menu then go to
Statistics

Step 5

Step 6:

Step 7:

Hit stat calculations,
then quadratic
regression

Put in your x’s and y’s

S Pagionin |1 0
Framusney Lt | © B

Comgry Lot | >
ek Catanariun | n

Joxgem

—
L

You are now happy and
have learned how to find
quadratic regression in
your TI Nspire.

28




Making a Residual Plot

Step 1: Step 2: Step 3:
Select New Document on the | Select Add Lists and Press where 4 is and type in
home screen. Spreadsheet. your X variable name.

[a]7

Step 4: Step 5: Step 6:

Enter all of your x variable Do the same for the observed | Go to the next column and
values into the x variable values in the next column. label it for your predicted
column. column

(7, T S P Ry Y
-y
¥
B W N Al e
P

=ik -

Step 7: Step 8: Step 9:

Then type in the linear Additionally, instead of Once you type in this
regression equation for your | typing in your variable in the | equation press enter
predicted values. Make sure | equation, type in al for

to type an equal sign in front | column one (x values) and if
of the equation. needed b1 for the second
column (y values)

29




—c
45
g 4
! 2 2:

- -,
K g

b
Pil-lzsu-ws [«]»]

Step 10:

Step 11:

Step 12:

Select menu, data, then fill

E= 1: Actions »

2: Insert »
3: Data ik
Siktis 2 Data (‘arturﬂ-

3: Fill

5: Summary Plot
6: Quick Graph

Select the next column

(column D) and label it to be

your residual column.

obs pred

resid

Type in an equal sign.

2Dt S 4 SI
7 1 4 3.25
1 |=125a1-175 [«]*] | -2 2 0.75
1 2 0.5
id [«
Step 13: Step 14: Step 15

Then type b1-c1 and hit
enter

A = N w n

=b1-c] 4>

Repeat steps 10 and 11

Now you should have all your
residual values

30




Graphing a Residual Plot
3

o
Qa

Step 1:

Step 2:

Step 3:

Open a new document, 4:
Add Lists & Spreadsheets

Insert your values and label
your axes.

Press Home, Add Data &
Statistics to New Document

== 1:Add Calculator
i_§'2:Add Graphs

29 3:Add Geomet

3 Add | < & Spreausheet
15:Add Data & Statistics
6:Add Notes

47:Add Vernier DataQuest™

®

! 0 0

2 2 25

- 4 45

L 6 80

5 8 68 L
5] es [4]*

Add Data & Statisties to: New Document

Set the correct x and y values

' 1.2 i3 *Doc 8 DEEd_EIm
o @
>

20 @

0

Press Menu, click 4:
Analyze, then 6: Regression,

then 1: Show Linear
E 1 plor Tune_ » )

ne ~
: Show Linear (mx+b)

e 4E B9

Ve

1
2: Show Linegr (a+bx)i Maahe e
3: Show Median—Median Ifetostal oo
4: Show Qua.dratlc i
5: Show Cubic i e
65: Show Quartic -
7: Show Power Es3loh ’
8: Show Expanential duals 14
9: Show Logarithmic alue
A: Show Sinusoidal I

b4

*Doe =

11|12 13

Press Menu, 4: Analyze, 7:
Residuals, 2: Show Residual
Plot

= 1: Plot Type
|5 2! Plot Proper]
k 3: Actions
i 4 Analyze |2
|4 5: Window/Zo I
11l 6: Settings. .. |4\ 5: Shade Under Function
20{ | AL 6: Regression »
9 1: Show Resldual Squares

il 9: Show N
/. A: Graph Trace

Residual
(=]
¢]
@
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Graph Systems of Equation

Step 2:

Step 3:

Step 1:

Open a new document and
click 2:Add Graphs

il 1.1 3 Unsaved < m X

115:Add Data & Statistics
6:Add Notes
:47:Add Vernier DataQuest™

Type in your first equation.

*Unsaved =

-6.67

-6.67 T

Click tab on the calculator to
graph another equation. Type
in your second
equation.(Example: y=-x-4)
EEREEY U
O r2ld)=—-4 =

*Unsaved —

Step 4:

Step 5:

Press enter to graph the line.
“ 11 ‘m ) *Unsaved <= m

667 %y
N[ /b= x+1
1
q0 00 T A E R 1
-6.67 1 20)=x—4

You can use a table to find
the solution by pressing ctrl
then t. This gives you a table

of values.
b2 B *Unsaved < A{]] >
6.67 2y X [o0i= Y[f200):= W2
Fx+1 x—4
....... o P 1 el |
10 1 10 1 A
[N 1 3. 5
) £2labete-al -2 [ 4 T »
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Graph Systems of Inequalities

Step 1: Step 2:
Open a new document. Delete the equal sign next to f1(x).
«EEN *Unsaved < o]l <
6.67 Ty N 1.1 i3 *Unsaved <
X 6.67%y
X
1
< x| 1
10 1 10
10 e i§
3=
Z
#1lx)4] 121 b -
Step 3: Step 4:

Select the desired sign from the drop down
menu.

Write your equation in the bar.

‘i
667%y
A 1.1 A3 *Unsaved — fﬂ
6.67 %y
1
X
1 ‘10 1 10
+ X
10 1. 1 10 k
2:<
3=
4:> ]
, y<x-4 @
#1lx) A
Step S: Step 6:

Click enter, the inequality should graph.

667 Ty

6.674

Press tab to enter another equation and repeat the
following steps.

Al 1.1 3 *Unsaved < C’ﬂ

6674y
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Finding Points of Intersection

Step 1:

Step 2:

Step 3:

To start this lesson, click on
new document so that you
can graph the functions that
you would like to graph.

&B rew Document

Put your first function in and
then press enter.

B k=261

Press tab to graph your
second function, put that
function in, and then press
enter.

ﬂ(x)=2x+3|

Step 4:

Step 5:

Step 6:

Press on menu, then click on
analyze graph, and after that
click on intersection.

There is a lower bound and an
upper bound. To the left of
the intersection, click the
mouse. Then, move the
mouse to the right side of the
intersection and click.

If you click on the dot of the
intersection, the points of the
intersection will be given.
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